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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
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Postfach 48 48
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept.

Customer is responsible to prevent unauthorized access to its plants, systems, machines and 
networks. Systems, machines and components should only be connected to the enterprise 
network or the internet if and to the extent necessary and with appropriate security measures 
(e.g. use of firewalls and network segmentation) in place.

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit:

http://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends to apply product updates as soon as available and to always 
use the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under

http://www.siemens.com/industrialsecurity.
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Preface 2
Purpose of this documentation

This documentation describes the licensing for the process control system PCS 7.           

The following topics are described:

● Selecting the correct licenses, referred to as license keys, for different PCS 7 software 
products.

● PCS 7 software packages and the required license keys.

Options for accessing PCS 7 documentation
The documentation required for PCS 7 includes the following types:

● PCS 7 Readme
The readme file is available in two versions:

– PCS 7 Readme (offline)
This version is installed by PCS 7 Setup. The file only contains general information and 
links to documents on the Internet.

– PCS 7 Readme (online)
This version contains all information on the installation and use of PCS 7 in the format 
which is already familiar to you. The file is only available on the Internet to keep it always 
up-to-date

Note

The information provided in the PCS 7 Readme (online) on the Internet takes 
precedence over all other PCS 7 documentation.

Read this PCS 7 Readme carefully, because it contains important information and 
amendments on PCS 7 .

● PCS 7 System Documentation
System documentation contains information that covers several products, such as 
configuration manuals and Getting Started manuals. This documentation serves as a 
guideline for the overall system and explains the interaction between the individual 
hardware and software components.
Note the information on "PCS 7 Documentation Portal Setup" in the product overview 
Process Control System PCS 7; PCS 7 ‑ Documentation; Section "Options for accessing 
the documentation"

● PCS 7 Product Documentation
Product documentation contains information about special hardware and software 
components. The individual documents provide detailed information on the specific 
component.

Full versions of the documentation are available from the "Technical Documentation SIMATIC 
PCS 7" website: www.siemens.com/pcs7-documentation (www.siemens.com/pcs7-
documentation)
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Required basic knowledge
General knowledge in the area of automation engineering and basic knowledge of PCS 7 is 
required to understand this documentation. It is also assumed that the reader knows how to 
use computers or other equipment similar to PCs (such as programming devices) with the 
Windows operating system. 

Preface
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Selecting the correct license keys 3
3.1 Selecting the correct license keys

Introduction
The configurable size of a PCS 7 plant is scalable. The software products for engineering 
station, operator station, SIMATIC BATCH station, Route Control station and SIMATIC PDM 
are licensed as follows:     

● Version-dependent license
This license enables the associated functionality, e.g. OS server redundancy.

● License type "Count Relevant License" (licenses with scalable size)
These licenses determine the configuration limits of this functionality, for example, OS 
Runtime 1000 PO. With licenses of the type "Count Relevant License", you can install 
several license keys whose licensed values are then added up. 

Process object
The following applies to licensing of the "PO" process objects in SIMATIC PCS 7:       

The following are counted as PCS 7 process object: 

● all SFC

● All block instances that meet the following criteria:

– Instance can be controlled and monitored.

– Instance generates alarms.

– Instance is not part of the driver library.

These objects are transferred to the OS and must be licensed. 
A block with operator control and monitoring has the attribute "S7_m_c = true" in the 
CFC block properties.

A process object can include the following blocks and objects:

● Blocks for operating and monitoring a system

● Objects for automation

● Objects for signal recording and signal processing

You can find additional information on process objects in the manual Process Control System 
PCS 7; Engineering System,  for example in the section "Counting and booking of process 
object licenses". 
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Licenses with scalable size (levels per component of the process control system)
The following table shows the levels in which the system size can be changed. 

Component of process 
control system

Levels of licenses Comment

Engineering system (ES) Loading of SIMATIC sta‐
tions 

PO:
● 100
● 1000
● 10000

"AS RT PO" license key
● Required for download to the AS, but not for test 

or S7 PLC Simulation.
● Only required once in the case of redundant 

systems.
Engineering system (ES) Loading of SIMATIC sta‐

tions 
PO:
● 0
● 100
● 250
● 500
● 1600

● Upgrade only possible for SE card
● SMART SE Card PO 800: Upgrade not possible

Operator station (OS) PO:
● 100
● 1000
● 5000

"OS RT PO" license key
● Single station system: maximum 5000 PO
● OS server: Maximum 12000 PO per OS server
● Maximum number of PO = 144000

Archiving with operator 
station

Archive values:
● 1500
● 5000
● 10000
● 30000

Maximum number of archive values that can be ar‐
chived per second with an OS server / OS single sta‐
tion system: 1000

Process Historian Note for use of the Process Historian:
Only operator stations license keys for ar‐
chive values.

Archive values from redundant data sources are coun‐
ted as only one tag each.

Information Server Clients:
● 1
● 3
● 5
● 10
 

A license is required for each active client connection. 
A client is any installed plug-in for Microsoft Excel or 
Word as well as the client of the web application.
Client licenses are counted per PC, not per client ap‐
plication. This means only one license is required 
even if more than one report client of a PC is connec‐
ted with the information server.

Information Server Data source access:
● 1
● 3

● Number of OS servers per Information Server 
A redundant OS server is counted as one OS 
server.

● The licenses are required if the Information Server 
directly accesses the OS server (without Process 
Historian).
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Component of process 
control system

Levels of licenses Comment

Maintenance Station 
(MS)

Asset tags 
(hardware components):
● 100
● 200
● 1000

Number of monitored hardware components within a 
PCS 7 project.

PCS 7 OS Web Option Web clients:
● 1
● 5
● 10

● Number of Web clients per Web server
● Maximum number of Web clients per PCS 7 

project: 100

BATCH stations (batch 
processes)

Units: 
● 1
● 10
● 50

Number of units within a PCS 7 project.

BATCH server (Web cli‐
ents)

Web clients:
● 1
● 5

● Number of Web clients per BATCH server
● One license key per server computer for 

redundant servers

BATCH server (Work 
memory)

Loading of work memory is needed for 
batch processing:
● 500 MB 

"BATCH Expansion (500MB)" license key
● If more than 1500 MB of work memory is needed 

for batch processing, this license key is necessary 
on a BATCH server PC.

● Each license key expands the work memory by 
500 MB. When batch processing, this enables the 
available SIMATIC BATCH Server’s work memory 
to be used almost to its complete capacity. 

● One license key per server computer for 
redundant servers

● Necessary for the expansion of the usable working 
memory for batch processing.
Information on the required working memory can 
be found in the manual Process Control System 
PCS 7; SIMATIC BATCH.

Route Control Station 
(Route Control)

Routes:
● 10
● 50

Number of activated routes in process mode (material 
transports)

PDM Number of devices: 
● 10
● 100
● 1000

Number of configurable devices

SIMATIC Management 
Console

Assigned PC stations
● 10
● 50
● 100

Number of managed computers

Selecting the correct license keys
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See also
Software and license keys for configuration with PCS 7 (Page 31)

Software and license keys for a single-station system with configuration (Page 33)

Software and license keys for Operator Stations (Page 35)

Software and license keys for BATCH Stations (Page 38)

Software and license keys for Route Control Stations (Page 40)

Software and license keys for the SIMATIC Management Console (Page 41)

Selecting the correct license keys
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3.2 Determining the process objects for the SIMATIC station
Information on license key levels is available in the catalog ST PCS 7.

License key for the AS
The required license key for all SIMATIC stations depends on the total number of process 
objects loaded and configured in a project (multiproject).   

When an AS is loaded, the loaded process objects are evaluated. The following procedure 
shows you how to calculate the number of process objects configured in a project or 
multiproject. 

PCS 7 V7.0 or higher: 
The number of process objects loaded into the AS is calculated by the executing application 
and is subtracted from the available process objects of the license. The value for the number 
of available process objects is always updated by the executing application. The license key 
"AS RT PO" of the type "Countable Objects" is used. 
For further information, refer to the section titled "Determining the process objects for the 
automation systems (Page 14)".   

Requirement
SIMATIC Manager is open.

Procedure
1. Select the multiproject or project in the component view.

2. Select the Options >PCS 7 license information  menu command.
The "PCS 7 license information" dialog box opens.

3. Select the entry "Process objects (AS RT PO)" in the left-hand table.

Result
The corresponding number of process objects is displayed in the right-hand window 
"Configured license objects." 

Note

The display of the license objects is based on the multiproject or project selected in the 
SIMATIC Manager.

The following information is also displayed below the window: 

● The existing license.

● The number of licenses currently still available and of process objects that can still be 
configured with them.

Selecting the correct license keys
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3.3 Determining the process objects for the automation systems

Overview
The following applies to licensing of process objects for the automation system:     

Licensing of process objects as of V7.0: 
Process objects (PO) requiring licenses include objects that are subject to operator control 
and monitoring and can generate messages. These objects have the block attribute "S7_m_c" 
and require the "PCS 7 - Runtime License AS" license with the "AS RT PO" license key.

The display in the "PCS 7 license information" dialog window can be used to determine the 
objects subject to licensing. For a description of the procedure see the section "Determining 
the process objects for the SIMATIC station (Page 13)".

Additional information
You can find additional information on process objects: 

● In the section "Insufficient license key – license key is not installed (Page 27) ".

● In the manual Process Control System PCS 7; Engineering System for example, in the 
section "Counting and booking process object licenses".

Installation of the AS RT PO licenses
Select the appropriate AS RT PO license installation for your engineering environment:

1. AS RT PO license installed on the local engineering PC
Install the AS RT PO license(s) in sufficient numbers on the engineering PC. The favorites 
list in the Automation License Manager (see menu "File > Settings") must not contain entries 
or the PCs listed do not have AS RT PO licenses.

2. AS RT PO license installed on a license server
Install the AS RT PO license(s) in sufficient number on the license server PC. The favorites 
list in the Automation License Manager (see menu "File > Settings") must contain the name 
of the license server PC. The local engineering PC must not have an AS RT PO license.

Selecting the correct license keys
3.3 Determining the process objects for the automation systems
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Display of objects in the "PCS 7 license information" dialog windows and the statistics function
The displays in the two dialog boxes differ as follows:

● "PCS 7 license information" dialog box 
When the "Process objects (AS RT PO)" option is selected, the objects that can be operated 
and monitored and generate messages are displayed in this dialog box. Only these require 
a license for process operation and the license key "AS RT PO".

● Statistic function in the "Chart Reference Data" dialog box
Statistical values are displayed with the menu command View > Statistics. The "Block 
instances" folder displays all the objects that can be operated and monitored under the 
entry "of which are OCM capable", regardless of whether or not they can generate 
messages.
You have the following options for opening the "Chart Reference Data" dialog box:

– In the CFC Editor or SFC Editor with the menu command Options > Chart Reference 
Data.

– When the chart folder of an AS is selected in the component view of the chart folder in 
SIMATIC Manager, with the menu command Options > Charts > Chart Reference 
Data.

PO volume of the CPU 410-5H
In PCS 7 V8.1 or later and CPU 410-5H with firmware version >= V8.1, you can use the 
Automation License Manager to increase the PO volume of a CPU 410-5H via an online 
upgrade of the System Expansion Card. 
You can find information about this in the documentation Process Control System PCS 7; 
Service Support and Diagnostics and in the Automation License Manager..

Selecting the correct license keys
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3.4 Calculating the process objects for the operator station
Information on license key levels is available in the catalog ST PCS 7.

License keys authorize users to use a specified number of process objects (PO) or archive 
values on the operator station. This number is listed in the "Validity" column in Automation 
License Manager.

License key for OS process objects (OS RT PO)
A defined number of process objects can be operated and monitored with this license key. The 
number of process objects that can be processed depends on the load on the operator station.

Visualization is possible for up to 2 hours on an engineering station without these license keys. 

You must transfer the license keys to the OS servers or OS single station systems (also 
engineering station).

An OS RT PO license key is not required for an OS client.

You can only use the editors for a limited period of time in demo mode.

Example:OS RT PO (Validity: 2000)

Use this license key to increase the number of process objects permitted in process mode by 
2000.

Requirements
● SIMATIC Manager is open.

● The "Compile OS" function is executed in the SIMATIC Manager. The number of configured 
process objects can then be determined.

Procedure
Proceed as follows to determine the configured and licensed process objects and archive tags 
of the OS:

1. Select the multiproject or project in the component view.

2. Select the Tools > PCS 7 License Information menu command. 
The "PCS 7 license information" dialog box opens.

3. Depending on the required information, select the entry in the table on the left:

– "OS process objects" entry
The corresponding number of OS process objects is displayed in the right-hand window 
"Configured license objects".

– "Archive tags" entry
The corresponding number of OS archive tags is displayed in the right-hand window 
"Configured archive tags".

Selecting the correct license keys
3.4 Calculating the process objects for the operator station
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Result

Note

The display of the license objects is based on the multiproject or project selected in the 
SIMATIC Manager.

Insufficient license key
see section "Insufficient license key – license key is not installed (Page 27)"

Extending the number of licensed process objects and archive tags
● You extend the number of licensed processed objects by installing additional OS RT PO 

license keys on the operator station (OS server or OS single station system).

● The number of licensed archive tags can be increased by installing more "WinCC Archive" 
license keys on the PC.

● The number of licensed archive tags for each license key is added up. "WinCC Archive" 
license keys can be combined as required.

● "WinCC Archive" license keys to expand the number of licensed archive tags are available 
starting with 1500 tags.

● With redundant systems, two archives with the corresponding number of archive tags must 
be configured.

Note
"WinCC Archive" license keys

Product name for separate order: "SIMATIC PCS 7, SOFTWARE OS ARCHIVE"

Example
If you need to archive approximately 11000 archive tags, install the following license keys: 

● "WinCC Archive" license key for up to 1500 archive tags 
(Basic license type; Single; License type: Count relevant; Validity: 1500)

● "WinCC Archive" license key for up to 10000 archive tags 
(Basic license type; Single; License type: Count relevant; Validity: 10000)

This licenses 11500 archive tags. 

Additional information
● WinCC Information System
● Section "Selecting the correct license keys (Page 9)"

● Section "Determining the archive values for the operator station (Page 18)"

Selecting the correct license keys
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3.5 Determining the archive values for the operator station

Introduction
Note the following conventions:

● The values of process tags of operator stations are referred to as archive tags below. 

● The archive values of a process tag are assigned to archive tags.

The total number of archive tags in a project, multiproject, or on an operator station can be 
determined. You can find information on how to expand the number of licensed archive values 
in the section "Calculating the process objects for the operator station (Page 16)".

License key for archive tags (WinCC Archive)
The values for a specific number of archive tags can be archived with operator stations using 
this license key. 

● Example 2: WinCC Archive (Validity: 1500)
This license key enables you to increase the number of archive tags which can be 
configured for the archive server by 1500 .

● Archive tags require licensing if any of the following properties is set with respect to the 
archiving:

Setting related to archiving Archive tag available in the following archive
Archiving ● Circular archive
Long-term archiving ● Circular archive

● Long-term archive 

● You can configure a maximum of 80 000 archive tags for each operator station. 

● You must transfer the license keys to the OS servers or OS single station systems.

● Product name for separate order: "SIMATIC PCS 7, SOFTWARE OS ARCHIVE"

Note
"WinCC Archive" license keys

Product name for separate order: "SIMATIC PCS 7, SOFTWARE OS ARCHIVE"

Using the Process Historian in the PCS 7 plant
The operator stations in a PCS 7 plant can send the archive values to a Process Historian.

Selecting the correct license keys
3.5 Determining the archive values for the operator station
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The Process Historian can archive the archive tags of all OS servers of a PCS 7 plant. 

Note

The Process Historian does not need separate license keys for archive tags of operator 
stations.

The number of licensed archive tags is derived from the total number of archive tags of all OS 
servers. 
The following license keys are required in the plant to use the Process Historian:

● On operator stations: WinCC Archive 

● On the Process Historian: Process Historian

Additional information
● WinCC Information System
● You can find information on how to expand the number of licensed archive values in the 

section "Calculating the process objects for the operator station (Page 16)".
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3.6 Calculating the asset tags (hardware components) for the 
Maintenance Station

License key for Maintenance Station
The license type of these license keys is "Count relevant license". The licensed scope is added 
together when several license keys are installed.             

This license key allows you to monitor a defined number of diagnostics objects (asset tags).

Example: Existing "Maintenance RT (100)" license key

This license key is sufficient for diagnosing up to 100 hardware components with a 
Maintenance Station. If you have three Maintenance RT (100) license keys on a Maintenance 
Station, you will be able to diagnose up to 300 hardware components.

Diagnostics objects
The following diagnostics objects are classed as an asset tag within a PCS 7 project:

● PC station

● Network component with diagnostics capability (for example, switch)

● Automation system (CPU)

● Distributed I/O (ET 200 station)

● Field device with diagnostics capability

● Object in the user diagnostics area (ASSETMON, AssetM)

Note

Diagnostics objects are counted as asset tags. 

Diagnostics objects are not counted as process objects (PO) of the operator station. The 
diagnostics object ASSETMON is an exception.

Requirement
SIMATIC Manager is open.

Procedure
1. Select the multiproject or project in the component view.

2. Select the Options >PCS 7 license information  menu command.
The "PCS 7 license information" dialog box opens.

3. Select the entry "Diagnostic objects (Maintenance RT)" in the left-hand table.

Selecting the correct license keys
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Result
The corresponding number of diagnostics objects is displayed in the right-hand window 
"Configured license objects". 

Note

The display of the license objects is based on the multiproject or project selected in the 
SIMATIC Manager.

Insufficient license key
see section "Insufficient license key – license key is not installed (Page 27)"
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3.7 Determining the units for the BATCH station

License key for BATCH station
A defined number of units can be operated and monitored with this license key. The number 
of units that can be processed depends on the utilization of the BATCH server.           

Example: BATCH UNITs (Validity: 20)

The license key for BATCH servers is sufficient to configure up to 20  units.

Requirement
SIMATIC Manager is open.

Procedure
1. Select the multiproject or project in the component view.

2. Select the Options >PCS 7 license information  menu command.
The "PCS 7 license information" dialog box opens.

3. Select the entry "SIMATIC BATCH units" in the left-hand table.

Result
The corresponding number of SIMATIC BATCH units is displayed in the right-hand window 
"Configured license objects". 

Note

The display of the license objects is based on the multiproject or project selected in the 
SIMATIC Manager. 
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3.8 Determining the routes for the Route Control station

License key for Route Control station         
For the process mode of SIMATIC Route Control, the number of active routes (material 
transports) is relevant and not the number of configured routes. The number of routes active 
in process mode is based on the process.

Example: Route Control Routes (Validity: 50)

This license key for Route Control servers can be used to simultaneously activate up to 50  
routes in process mode. 

Determination of routes
The following options are available for determining the number of routes: 

● The status bar in the Route Control center shows how many routes were active at the same 
time after restarting the Route Control server.

● The number of routes can be determined in the "PCS 7 license information" dialog box in 
the SIMATIC Manager. More information is available in the following text.

Determining the number of routes in the SIMATIC Manager
1. Select the multiproject or project in the component view.

2. Select the Tools > PCS 7 License Information menu command. 
The "PCS 7 license information" dialog box opens.

3. Select the entry "Route objects (Route Control Server)" in the left-hand table. 
The corresponding number of routes is displayed in the right-hand window "Configured 
license objects".

Note

The display of the license objects is based on the multiproject or project selected in the 
SIMATIC Manager.

Insufficient license key
see section "Insufficient license key – license key is not installed (Page 27)"

New license
If you have installed the license, restart the Route Control server. 
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3.9 Determining the PDM objects for PC stations with SIMATIC PDM

Overview
SIMATIC PDM must be installed before it can be started. The software package contains all 
SIMATIC PDM software. Depending on the usage scenario, you only need to install certain 
applications.

The license type of these license keys is "Count relevant license". The licensed scope is added 
together when several license keys are installed. 

This license key allows you to monitor a defined number of diagnostics objects (asset tags).

Example: Existing "Maintenance RT (100)" license key

This license key is sufficient for diagnosing up to 100 hardware components with a 
Maintenance Station. If you have three Maintenance RT (100) license keys on a Maintenance 
Station, you will be able to diagnose up to 300 hardware components (Calculating the asset 
tags (hardware components) for the Maintenance Station (Page 20)).

License for S7 DSGW (data record gateway)
The "SIMATIC PDM Routing" option is not included in the SIMATIC PDM stand alone product 
package. 
Licensing for use of the S7 DSGW (data record gateway) for gateways from the plant bus 
(Ethernet) to field buses (PROFIBUS) takes place via TAG licenses.
TAG licenses are booked depending on the quantity according to the following rules:

● 10 TAG: per S7 DSGW with a PROFIBUS subnet

● 20 TAG: per S7 DSGW with more than one PROFIBUS subnet 

● 10 TAG: per IE/PB link

● 0 TAG: for Ethernet or PROFINET networks 

Additional information
You can find additional information on PDM objects: 

● In the section "Insufficient license key – license key is not installed (Page 27) ".

● In the manual Process Control System PCS 7; Engineering System for example, in the 
section "Counting and booking process object licenses".

Display of objects in the "PCS 7 license information" dialog windows and the statistics function
Product variants for stand-alone use
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SIMATIC PDM is available as a stand-alone variant with the "Basic" and "Single Point" licenses 
and can thus be used independently of SIMATIC S7 or SIMATIC PCS 7.

● The "Single Point" product variant can be used for exactly one field device with a point-to-
point connection. A project is permitted to contain a maximum of one object subject to 
licensing. This product variant cannot be extended with respect to functions or capacity 
using SIMATIC PDM options. No functional extensions (upgrades) are provided for this 
variant.

● The "Basic" product variant can be extended with respect to functions and capacity using 
SIMATIC PDM options. Functional extensions (upgrades) are provided for this variant.
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3.10 Determining the number of computers for the SIMATIC Management 
Station

Information on license key levels is available in the catalog ST PCS 7.

License key for the SIMATIC Management Console (x)
A defined number of computers can be connected with the Management Console with this 
license key. The connection is only possible if the SIMATIC Management Agent service is 
installed on the computers in the system. You can apply the functions of the Management 
Console to the connected computers. 

You need one license key object for each managed computer in the Management Console 
network. 

Example: SIMATIC Management Console (scope: 50) 

● You need one license key object for the Management Console computer. You can connect 
an additional 49 computers to the Management Console. 

Requirement
The SIMATIC Management Console is open.

Procedure
Select the menu command View > SMAgent license view.
The dialog box displays the following information:

● Number of occupied licenses
The number of used SMA license keys shows how many computers are connected to the 
Management Console.

● Number of free licenses
The number of free SMA license keys shows how many additional computers can be 
connected to the Management Console.

Selecting the correct license keys
3.10 Determining the number of computers for the SIMATIC Management Station

Licenses and configuration limits (V9.0) 
26 Installation Manual, 05/2017, A5E39222309-AA



3.11 Insufficient license key – license key is not installed

Reactions
Below you find the reactions of the PCS 7 components in the following situations:

●  Insufficient license key

●  Missing license keys
Example for missing license keys are:

– License key is not installed

– Access to license key is not possible, for example, license server is not available

License key for the AS
● If the current program contains fewer process objects than the previously downloaded 

project, the download operation automatically increases the number of available process 
object licenses. If not enough licenses are available, the license violation generates a 
corresponding message that must be confirmed. Now you may either terminate the 
download or continue just the same. The number of the required but unavailable licenses 
is recorded as a shortage. If you have purchased additional licenses, these missing licenses 
are included and registered in the ALM at the next download.

License key for OS process objects (OS RT PO)
● Missing license keys

The OS program automatically switches to demo mode.

● Insufficient license key
If you open a project with an insufficient number of configurable process objects, the OS 
program switches to demo mode automatically.

License key for Maintenance Station
Objects with diagnostic capability are 

License key for PC stations with SIMATIC PDM
● Missing license keys for PDM tags

The SIMATIC PDM automatically switches to demo mode.
Without license keys, you can configure a maximum of 4 devices.

● Insufficient license keys for PDM tags
The SIMATIC PDM automatically switches to demo mode.

● Only the license key for options requiring a license (for example, SIMATIC PDM Extended) 
is missing.
The license-specific functions are not available (for example, routing via S7 DSGW).

Reaction 
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If after starting SIMATIC PDM you receive a message stating that demo mode is activated, 
note the following:

● The SIMATIC PDM status line displays the information "Demo".

● The following function limitations are in effect:

– The processing of the project with other editors is unrestricted.

– Objects that are not affected by the infringement of the license conditions can be created.

– The communication functions to PDM objects are locked.

– Online dialog boxes of field devices can only be opened "offline".

License key for BATCH station
● Missing license keys

The OS program automatically switches to demo mode.

● Insufficient license key
If you open a project with an insufficient number of configurable process objects, the OS 
program switches to demo mode automatically.
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License key on a BATCH Server PC
● Behavior in the case of missing "BATCH Web Client" license keys on a BATCH Server PC

– If there is no "BATCH Web Client" license key for the BATCH Web Client on a BATCH 
Server PC, an error message is displayed on the BATCH Web Client when a connection 
is to be established. 
A connection is not possible without a license.

– If a server is redundant, you will require the license key on each of that server's PCs.

● Behavior in the case of insufficient "BATCH Expansion (500MB)" license keys on a BATCH 
Server PC
BatchCC and OS Controls
From SIMATIC BATCH V9.0 onwards the performance capacity of the BATCH Server will 
be increased. BATCH Server can process larger quantities (depending upon the work 
memory and the performance capacity of the PC).
Therefore, the available working memory can be almost completely used by the SIMATIC 
BATCH system. 
When the licensed working memory limit has been exceeded, no batch can be released 
and no released batch can be started. Furthermore, chained batches, or batches that are 
programmed for an automatic start, are no longer able to be started. 
A message in the PCS 7 OS message system will be generated. Batches that are already 
running will not be affected. 
When enough licensed working memory is again available, you may once more start and 
release batches. 

– As soon as more than 1500 MB of work memory is needed for batch processing, this 
license key is necessary on a BATCH server PC.

– Each license key expands the work memory by 500 MB. When batch processing, this 
enables the available SIMATIC BATCH Server’s work memory to be used almost to its 
complete capacity.

– If a server is redundant, you will require the license key on each of that server's PCs.

SIMATIC BATCH API
When the licensed working memory limit has been exceeded, the commands "Start" and 
"Release" will no longer function and will be rejected in SIMATIC BATCH API.

License key for Route Control station
● Insufficient license key – server license key is installed

– If the Route Control server detects a license key for 30, 100 or 300 routes when powering 
up, the maximum number of material transports that can occur at any one time is limited 
to this value. 

– This means when the server receives its 31st, 101st or 301st route request, the Route 
Control center shows that there is no license key or that it has been exceeded. The 
Route Control server runs on.

● Insufficient license key – server license key is not installed
If there is no license key installed on the Route Control server, the server is limited to a 
maximum of 300 routes (maximum limit). Since the Route Control server has no information 
on the actual system size, it adopts a safe stance - you can still run the system without a 
license. The fact that there is no license is indicated on the Route Control center. 
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Licensing of PC stations 4
4.1 Software and license keys for configuration with PCS 7

Overview
The following tables show the software packages and the required license keys for the 
engineering station of PCS 7:         

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Note

You can learn about the versions for the current program package on the Process Control 
System; SIMATIC PCS 7 DVD in the Process Control System PCS 7; PCS 7 Readme file (see 
"Preface (Page 7)").

Engineering station

Designation License key Optional Comment
AS/OS engineering AS Engineering

OS Engineering
  

Runtime license AS AS RT PO  Only required for download
BATCH Engineering - X  
Route Control Engineer‐
ing

Route Control Engineering X  

Maintenance Station En‐
gineering

Maintenance ES X  

PDM PDM Basic
PDM Integration in STEP 7
PDM Routing
PDM Extended

X  

PDM Tags PDM TAG X Count relevant license
S7 PLC Simulation S7-PLCSIM X  
Version Trail Version Trail X  
Version Cross Manager Version Cross Manager X  
Import/Export Assistant IEA X  
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Designation License key Optional Comment
Advanced Engineering 
System

AdvancedES X  

SIMATIC NET 1. BCE
2. Industrial Ethernet
3. S7-REDCONNECT

(1st + 2nd) 
alternative
(3rd) X

1. Only for standard 
Ethernet network 
adapters (not required for 
SIMATIC NET CP).

2. When using SIMATIC 
NET CP, e.g. CP1623.

3. When using high 
availability connections.
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4.2 Software and license keys for a single-station system with 
configuration

Overview
The following tables show the software packages and the required license keys for a single-
station system in PCS 7 with configuration. 

● The single-station system includes the engineering station and the operator station (single-
station system) as basic functions.

● The following can be installed as optional functions, for example:

– BATCH station (single-station system)

– Route Control (single-station system)

– Maintenance Station (single-station system)

– PDM

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Note

You can learn about the versions for the current program package on the Process Control 
System; SIMATIC PCS 7 DVD in the Process Control System PCS 7; PCS 7 Readme file (see 
"Preface (Page 7)").

Single-station system

Designation License key Optional Comment
AS/OS engineering AS Engineering

OS Engineering
  

Runtime license AS AS RT PO  Only required for download
Count relevant license

OS software single sta‐
tion

OS Single Station Basic   

Runtime License OS OS RT PO  max. 2000 PO
Count relevant license

OS archives 1) WinCC Archive 1) X Count relevant license
BATCH single-station 
package 

BATCH Single Station User 
BATCH Single Station System

X  

BATCH units BATCH Units X Count relevant license
BATCH server (Web cli‐
ents)

BATCH Web Client X Count relevant license

BATCH server (Work 
memory)

BATCH Expansion (500MB) X Count relevant license

Route Control Engineer‐
ing

Route Control Engineering X  
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Designation License key Optional Comment
Route Control server Route Control Server X restricted to 30 routes; 

max. 300 simultaneous ma‐
terial transfer operations

Route Control Center Route Control Center X Licensing for RC client
Route Control routes Route Control Routes X Count relevant license
Maintenance Station En‐
gineering

Maintenance ES X  

Maintenance Station 
Runtime Basic Package

Maintenance RT X Count relevant license

PDM PDM Basic
PDM Integration in STEP 7
PDM Routing
PDM Extended

X  

PDM Tags PDM TAG X Count relevant license
S7 PLC Simulation S7-PLCSIM X  
Version Trail Version Trail X  
Import/Export Assistant IEA X  
SIMATIC NET 1. BCE

2. Industrial Ethernet
3. S7-REDCONNECT

(1st + 2nd) 
alternative
(3rd) X

1. Only for standard 
Ethernet network 
adapters (not required 
for SIMATIC NET CP).

2. When using SIMATIC 
NET CP, e.g. CP1623.

3. When using high 
availability connections.

1) Product name for separate order: "SIMATIC PCS 7, SOFTWARE OS ARCHIVE"
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4.3 Software and license keys for Operator Stations

Overview
The following tables show the software packages and the required license keys for the following 
PC stations of PCS 7: 

● Operator station (single-station system / redundant single-station system)

● Operation Station server / redundant server

● Operator station client

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Note

You can learn about the versions for the current program package on the Process Control 
System; SIMATIC PCS 7 DVD in the Process Control System PCS 7; PCS 7 Readme file (see 
"Preface (Page 7)").

OS single-station system/redundant single-station system

Designation License key Optional Comment
OS software single sta‐
tion

OS Single Station Basic  Not required for non-redundant 
OS

OS software single sta‐
tion redundancy

OS Single Station Redun‐
dancy

 In the case of a redundant OS: 
Alternative license key to "OS 
Single Station Basic" license key

Runtime License OS OS RT PO  max. 5000 PO
Count relevant license

OS archives 1) WinCC Archive 1) X Count relevant license
OpenPCS 7 for connect‐
ing to the local OPC serv‐
er

OpenPCS 7 Station / OS
or
OpenPCS 7 Station

X License key only (without soft‐
ware installation) required. 

Web server 1. OS Web Server Basic
2. OS Web Server

X 1. Web server and Web 
diagnostics server are used 
alternately.

2. License key for number of 
Web clients
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Designation License key Optional Comment
Web diagnostics server
Web diagnostics client

WebDiagnose Server
WebDiagnose Client 

X Web server and Web diagnos‐
tics server are used alternately.

SIMATIC NET 1. BCE
2. Industrial Ethernet
3. S7-REDCONNECT

(1st + 2nd) 
alternative
(3rd) X

1. Only for standard Ethernet 
network adapters (not 
required for SIMATIC NET 
CP).

2. When using SIMATIC NET 
CP, e.g. CP1623.

3. When using high availability 
connections.

1) Product name for separate order: "SIMATIC PCS 7, SOFTWARE OS ARCHIVE"

OS server / redundant server

Designation License key Optional Comment
OS software server OS Server  Not required for non-redundant 

OS
OS software server re‐
dundancy

OS Server Redundancy  In the case of a redundant OS: 
Alternative license key to "OS 
Server" license key

Runtime License OS OS RT PO  Max. PO: 12000
Count relevant license

OS archives 1) WinCC Archive 1) X Count relevant license
Information Server Information Server  Required for when using an In‐

formation Server
Information Server Information Server - Client 

Access
X Count relevant license

Information Server Information Server - Data‐
source Access

X Count relevant license

BATCH server BATCH Server X  
BATCH units BATCH Units X Count relevant license
BATCH server (Web cli‐
ents)

BATCH Web Client X Count relevant license

BATCH server (Work 
memory)

BATCH Expansion 
(500MB)

X Count relevant license

Route Control server Route Control Server X restricted to 30 routes; max. 300 
simultaneous material transfer 
operations

Route Control routes Route Control Routes X Count relevant license
OpenPCS 7 for connect‐
ing to the local OPC serv‐
er

OpenPCS 7 Station / OS X License key only (without soft‐
ware installation) required.
Software installation only neces‐
sary for connecting to all OS 
servers. 
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Designation License key Optional Comment
Maintenance Station 
Runtime Basic Package

Maintenance RT X Count relevant license

SIMATIC NET 1. BCE
2. Industrial Ethernet
3. S7-REDCONNECT

(1st + 2nd) 
alternative
(3rd) X

1. Only for standard Ethernet 
network adapters (not 
required for SIMATIC NET 
CP).

2. When using SIMATIC NET 
CP, e.g. CP1623.

3. When using high availability 
connections.

1) Product name for separate order: "SIMATIC PCS 7, SOFTWARE OS ARCHIVE"

OS client

Designation License key Optional Comment
OS software client OS Client   
Web server 1. OS Web Server Basic

2. OS Web Server
X 1. Web server and Web 

diagnostics server are used 
alternately.

2. License key for number of 
Web clients

Web diagnostics server
Web diagnostics client

WebDiagnose Server
WebDiagnose Client 

X Web server and Web diagnos‐
tics server are used alternately.

BATCH client BATCH Client X  
Route Control Center Route Control Center X The license for RC client is ei‐

ther located directly on the client 
or, alternatively, on the ES.

SFC visualization SFC Visualization X  
OpenPCS 7 (OS client) OpenPCS 7 Station / OS X  
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4.4 Software and license keys for BATCH Stations

Overview
The following tables show the software packages and the required license keys for the following 
PC stations of PCS 7:         

● BATCH server/BATCH redundant server

● BATCH Client

Additional information on the single-station system for BATCH can be found in the section 
"Software and license keys for a single-station system with configuration (Page 33)". 

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Note

You can learn about the versions for the current program package on the Process Control 
System; SIMATIC PCS 7 DVD in the Process Control System PCS 7; PCS 7 Readme file (see 
"Preface (Page 7)").

BATCH server/BATCH redundant server

Designation License key Optional Comment
BATCH server BATCH Server  ● One license key per server 

computer for redundant 
servers

BATCH Basic BATCH Basic  ● Alternative to 
"BATCH Server" 
license key, restricted 
functionality;

● One license key per server 
computer for redundant 
servers

 
BATCH units BATCH Units  Count relevant license
BATCH server (Web cli‐
ents)

BATCH Web Client X Count relevant license
In the case of redundant serv‐
ers, the necessary licenses 
must be available on each 
server.

BATCH server (Work 
memory)

BATCH Expansion 
(500MB)

X Count relevant license
In the case of redundant serv‐
ers, the necessary licenses 
must be available on each 
server.
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Designation License key Optional Comment
BATCH API BATCH API X  
SIMATIC NET 1. BCE

2. Industrial Ethernet
3. S7-REDCONNECT

(1st + 2nd) al‐
ternative
(3rd) X

1. Only for standard Ethernet 
network adapters (not 
required for SIMATIC NET 
CP).

2. When using SIMATIC 
NET CP, e.g. CP1623.

3. When using high 
availability connections.

BATCH Client

Designation License key Optional Comment
BATCH client BATCH Client   
BATCH recipe system BATCH Recipe System X Only required if recipes will be 

created on the BATCH client.
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4.5 Software and license keys for Route Control Stations

Overview
The following tables show the software packages and the required license keys for the PC 
stations of PCS 7 Route Control.

Additional information on the single-station system with Route Control can be found in the 
section "Software and license keys for a single-station system with configuration (Page 33)".

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Note

You can learn about the versions for the current program package on the Process Control 
System; SIMATIC PCS 7 DVD in the Process Control System PCS 7; PCS 7 Readme file (see 
"Preface (Page 7)").

RC Server

Designation License key Optional Comment
Route Control server Route Control Server  restricted to 30 routes; max. 300 

simultaneous material transfer 
operations

Route Control routes Route Control Routes  Count relevant license
SIMATIC NET 1. BCE

2. Industrial Ethernet
3. S7-REDCONNECT

(1st + 2nd) 
alternative
(3rd) X

1. Only for standard Ethernet 
network adapters (not 
required for SIMATIC NET 
CP).

2. When using SIMATIC NET 
CP, e.g. CP1623.

3. When using high availability 
connections.

RC Client 

Designation License key Optional Comment
Route Control Center Route Control Center  The license for RC client is ei‐

ther located directly on the client 
or, alternatively, on the ES.
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4.6 Software and license keys for the SIMATIC Management Console

Overview
The following tables show the software packages and the required license keys for working 
with the SIMATIC Management Console.

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Note

You can learn about the versions for the current program package on the Process Control 
System; SIMATIC PCS 7 DVD in the Process Control System PCS 7; PCS 7 Readme file (see 
"Preface (Page 7)").

Computers with the Management Console

Designation License key Optional Comment
SIMATIC Manage‐
ment Console 

SIMATIC Management Con‐
sole 

 We recommend only one 
computer per network with a 
Management Console 

SIMATIC Manage‐
ment Console (x;x;x) 

SIMATIC Management Con‐
sole (x;x;x) 

 Per managed computer; 
number of managed comput‐
ers in the PCS 7 system
Count relevant license

Managed computers 

Note
License keys for working with the SIMATIC Management Console 

You must install the license keys locally so that they are available on the computer with the 
SIMATIC Management Console.
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4.7 Software and license keys for SIMATIC PDM

Overview
SIMATIC PDM is an optional package in SIMATIC PCS 7.

The tables below show the software packages and the required license keys for PC stations 
with SIMATIC PDM. 

You can find information on license key levels in the section "Selecting the correct license 
keys (Page 9)".

Information on the software packages and license keys for the different PC stations is available 
in the following sections:

● For the engineering station and PDM in the section "Software and license keys for a single-
station system with configuration (Page 33)".

● For a separate PC with SIMATIC PDM in the section "Determining the PDM objects for PC 
stations with SIMATIC PDM (Page 24)".

SIMATIC PDM

Product name License key SIMATIC PCS 7 
(ES
AS
OS
BATCH
Route Control)

SIMATIC PCS 7 
BOX RTX
(only
AS
OS
BATCH 
Route Control)

Comment 

Software on the SIMATIC 
PCS 7 DVD
(SIMATIC PDM)

 (Z)   

Maintenance Station Maintenance RT (Z) (Z) (Z)  

Product variants for stand-alone use
SIMATIC PDM is available as a stand-alone variant with the "Basic" and "Single Point" licenses 
and can thus be used independently of SIMATIC S7 or SIMATIC PCS 7.

● The "Single Point" product variant can be used for exactly one field device with a point-to-
point connection. A project is permitted to contain a maximum of one object subject to 
licensing. 
This product variant cannot be extended with respect to functions or capacity using 
SIMATIC PDM options. No upgrades are provided for this variant.

● The "Basic" product variant can be extended with respect to functions and capacity using 
SIMATIC PDM options. Upgrades are provided for this variant.
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Data volumes 5
5.1 Overview of the quantity structures of PCS 7

Introduction
The section describes the following PCS 7-specific quantity structures:   

● Automation systems

● Operator station

Additional information
● Information on the quantity structure of SIMATIC BATCH can be found in the manual 

SIMATIC BATCH  in the section "Product introduction and installation > Quantity structures".

● Information on the quantity structure of SIMATIC Route Control can be found in the manual 
SIMATIC Route Control in the section "Appendix > Quantity structures".
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5.2 Quantity structures for automation systems of PCS 7

Configuration limits of AS with standard and high availability
The values in the following tables are not AS-specific maximum values for the corresponding 
position, but rather represent a typical distribution of the available AS total capacity in mixed 
operation of all positions of a related block.   

The tables below show the typical mixed configuration limits for SIMATIC PCS 7 automation 
systems using the Advanced Process Library (APL)

Mixed configuration limits using the Advanced Process Library (APL)

Table 5-1 Mixed configuration limits for high availability automation systems (basis: Advanced Process Library)

 AS 412H AS 414H AS 416H AS 417H
V6.0 V6.0 V6.0 V6.0

Analog value measurements 10 100 400 600
Digital value measurements 20 250 800 1000
PID controllers 5 50 150 200
Motors 7 75 200 400
Valves 7 75 200 400
SFC 0 15 100 200
Steps 0 150 1000 2000
Dosing 0 3 25 50

 
Digital inputs  (DI) 30 300 1200 1800
Digital outputs (DO) 10 110 400 650
Analog inputs (AI) 15 150 600 900
Analog outputs (AO) 5 50 200 350

 
Process objects (PO) 30 350 1200 2000

Table 5-2 Mixed configuration limits for automation systems (basis: Advanced Process Library)

 AS 414-3 AS 414-PN/
DP

AS 416-2 AS 416-3 AS 416-PN/
DP

AS 417-4 PCS 7 ... 
RTX 1)

V7.0 V7.0 V7.0 V7.0 V7.0 V7.0 V4.6 (2010)
Analog value measure‐
ments

100 100 200 400 400 500 400

Digital value measure‐
ments

250 250 450 800 800 1000 800

PID controllers 50 50 75 150 150 180 150
Motors 75 75 100 200 200 350 200
Valves 75 75 100 200 200 350 200
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 AS 414-3 AS 414-PN/
DP

AS 416-2 AS 416-3 AS 416-PN/
DP

AS 417-4 PCS 7 ... 
RTX 1)

V7.0 V7.0 V7.0 V7.0 V7.0 V7.0 V4.6 (2010)
SFC 15 15 40 100 100 200 100
Steps 150 150 400 1000 1000 2000 1000
Dosing 3 3 15 25 25 50 25

 
Digital inputs  (DI) 350 350 600 1200 1200 1700 1200
Digital outputs (DO) 100 100 200 400 400 550 400
Analog inputs (AI) 175 175 300 600 600 800 600
Analog outputs (AO) 75 75 100 200 200 250 200

 
Process objects (PO) 350 350 600 1200 1200 1800 1200

1) SIMATIC PCS 7 BOX RTX, SIMATIC PCS 7 AS RTX, SIMATIC PCS 7 AS mEC RTX with WinAC RTX.

Mixed configuration limits for AS with CPU 410
The CPU 410 can be used for standard automation systems as well as high availability 
automation systems. The configuration limits are scalable and depend on the licensing. You 
define the configuration limits of the CPU 410H with a System Expansion Card. 

You can find additional information on this in the system manual Process Control System 
PCS 7; PCS 410-5H Process Automation.

Table 5-3 Mixed configuration limits for automation systems

 AS 410H
Applied library Advanced Process Library
Scalable by means of license from to
Analog value measurements 10 600
Digital value measurements 20 1000
PID controllers 5 200
Motors 7 400
Valves 7 400
SFC 0 200
Steps 0 2000
Dosing 0 50

 
Digital inputs  (DI) 30 1800
Digital outputs (DO) 10 650
Analog inputs (AI) 15 900
Analog outputs (AO) 5 350

Data volumes
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 AS 410H
Applied library Advanced Process Library
Scalable by means of license from to

 
Process objects (PO) 30 26001)

1) In PCS 7 V8.1 or later, you can use the Automation License Manager to increase the PO volume of a CPU 410-5H via an 
online upgrade of the System Expansion Card (as of firmware version 8.1). The PO volume of the System Expansion Card 
is limited to 2600 process objects. Starting from this PO volume, the limitation of the PO volume is canceled.

Data volumes
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5.3 Quantity structures for the operator station

OS configuration limits (per multiproject)
Information on licensing and process objects "PO" can be found in section "Selecting the 
correct license keys (Page 9)".   

Parameter Value
Max. number of servers / server pairs in the project (OS, BATCH, 
Route Control and archive servers)

18

Max. number of automation systems per OS server / server pairs 64
Max. number of OS clients in multi-client operation (per multi-station 
system)

40 
Note: If each OS client has ac‐
cess to all OS servers/server 
pairs. The maximum number of 
monitors of these OS clients is 
limited to 60."

Max. number of monitors per operator station in multi-channel oper‐
ation

4

Maximum number of permitted monitors for process mode in a sys‐
tem

40

Max. number of OS areas 64
Max. number of windows per monitor 1 up to 16 (adjustable)
Number of trends per trend window 10
OS process picture time-out (100 process symbols) < 2 s
Max. number of process objects:
● per OS single-station system 8 500 PO
● per OS server 12 000 PO
● per AS 2 600 PO
● per project 216 000 PO
Max. number of configurable alarms per server / single-station 200 000
Number of process tags:
● per OS single-station system approximately 4 500
● per OS server approximately 7 000
● per multi-station system approximately 128 000
Integrated high-performance archive system (cyclic buffer)
Based on Microsoft SQL server for:
● Process value archiving (per OS server/single-station system) approximately 1 500/s
● Message archiving (per OS server/single-station system) Messages as continuous load:

ca. 10/s 
Message burst ca. 3 000 with a 
duration of 4 s
Note: If the time until the next 
message burst is less than five 
minutes, messages can be lost.

Long-term archiving

Data volumes
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Parameter Value
Process value archiving with SIMATIC Process Historian For additional information on the 

configuration limits, refer to the 
SIMATIC Process Historian doc‐
umentation.
The Process Historian does not 
need separate license keys for 
archive tags of operator stations.

Max. number of PCS 7 Web clients 100
Max. number of PCS 7 Web Diagnostics clients 3
Number of maintenance stations 1 maintenance station for moni‐

toring diagnostic variables

Data volumes
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M
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Determining the license key, 20
Licensing server, 35
Licensing single-station system, 33
Number of process objects, 20

N
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Operator station

Client, 35
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BATCH station, 22
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Licensing, 9
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PC station, 13
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R
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Route Control

Licensing single-station system, 33
Server/client licensing, 40
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S
SIMATIC Management Console

Licensing, 41
SIMATIC PDM, 42

License key, 24
Licensing, 42

Software
BATCH, 38
Engineering station, 31
License key, 31, 33, 35, 38, 40, 41
Maintenance Station, 35
OS, 35
Route Control, 40
SIMATIC Management Console, 41
SIMATIC PDM, 42
Single-station system, 33

V
Validity of the documentation, 7
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